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USE AND DISTRIBUTION NOTICE

• Santa Clara County RACES authorization is granted to use and 
duplicate this material as-is as long as this page and the 
copyright notices on each page are included, acknowledging 
Santa Clara County ARES/RACES as the holder of the 
copyright. 

• Permission is granted to adapt this presentation to your 
needs as long as you acknowledge our copyright and include a 
note similar to "adapted with permission from Santa Clara 
County ARES/RACES”

• For additional information on training or any of our programs 
send an email to: info@scc-ares-races.org
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ARES and Amateur Radio Emergency Service are registered service marks of the American Radio Relay League Incorporated and are used by permission.
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Housekeeping

• Introductions

• Pen/pencil, paper

• Cell phones

• Side conversations

• Questions

• Breaks

• Restrooms

• Do not park in side parking lot

• Do not wander around the building

• In case of emergency
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2024

9033

Agenda

• Message Passing Skills
• Training
• ICS Forms
• Credential Updates
• Packet Network Update
• Monthly Packet Message Passing 
• P1 and HF Credentials & SHARES
• Weekly Packet Practice
• Safety Issue Observed: no fuses in power cables
• Working with a Served Agency
• W2XSC BBS Failure 
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Message Passing Skills
Can you send what the served agency needs?

Tim Howard, KE6TIM
Revised 10-Dec-2024
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Why is Message Passing Important
• Trained Amateur Radio Operators

o Do more than push a PTT button.
o Know how to get agency specific messages from Point A to 

Point B accurately and efficiently, even when other systems 
are failing.

• No mater how much experience you have, your skills 
become stale without practice.

• We encourage everyone to attend the training classes 
every few years.  

• We all think we are good enough, but how good is 
good enough?

• Let’s try some examples.

• No judgement, just some fun to see what we can do.
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Some Examples
1. Please call Ammiras at (669) 345-1356

2. Send 1030, 25 mg tablets of pantoprazole

3. The form is at      
www.scclaet.org/Download/SCCLAET_Disaster_Forms.pdf

4. Meet us at 37°34’5”N  121°8’2”W

5. The Password is Cot3two6Ten9

6. Deliver to 408 8th Ave, Bldg B to arrive by 1800

7. Truck may have 600 gal of flammable C6H12 to unload

8. We have 4 patients for transport to 2 North 1st St.

9. Part # for the peristaltic pump is D45FCGH15a

10. Cases of flu virus are <300 / 10,000 residents & falling

°
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https://www.scc-ares-races.org/operations.shtml#MHP
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Message Passing Skills
• We schedule two Message Passing Classes each year.

o January 27th

o July 19th

• Quarterly Training Nets on the 3rd Tuesday of the 1st

Month in each Quarter at 7pm on the Resource Net 
Repeaters is another opportunity to learn and practice.

• January 21st  - details on web site--sign up.

Training

Judy Halchin, KK6EWQ
Revised 22-Nov-2024
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• 24 training classes in 2024
• 16 unique classes
• 40 people in Introduction to Emergency 

Communications classes                          
(not counting instructors and staff)

• 2025 schedule is very similar to this 
year’s

Classes
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• Monthly packet practice
• Pop-up packet drill
• Quarterly message passing practice 
• Quarterly drills at County EOC radio 

room
• Annual exercise in September

Practices
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• Hospital employees got ham radio 
licenses (or already had them)

• ICS-214 and ICS-309 training videos
• Basic voice and packet training for 

hospital employees

Hospital Training
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2025
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ICS Forms

Tim Howard, KE6TIM
Revised 10-Nov-2024
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Forms Updated in 2024
• In 2023 the Public Health Department relocated their 

operations center and renamed it:
o Was: Medical Health Joint Operations Center - MHJOC
o Is: Public Health Department Operations Center - PHDOC

• This resulted in updates to Hospital Forms and the 
Recommended Form Routing Sheet.

• We are still seeing numerous cases of MHJOC still being 
used instead of PHDOC.

• The Recommended Form Routing Sheet is your friend.
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Forms Updated in 2024 (Cont.)
• The RACES Mutual Aid Request Form was updated.

• The primary changes were on page two used at the 
County EOC to assist with resource assignment and 
tracking.

• Some changes on the front for cities.

• Those are used by city ECs/AECs and the changes 
were shared with city RACES leaders at a quarterly EC 
Council Meeting.
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Errors in Form Completion
• We continue to see errors in form completion.

• Primarily 214 Activity Log and 309 Communications Log.

• Judging from the call signs, it is mostly newer operators; 
but, some experienced operators also make errors.

• So new or experienced, we all can do better.

• These forms are legal documents and need to be 
accurate.  

• Let’s review some of the more common errors to help us 
all learn.  Names have been redacted to protect the 
innocent.
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What is missing or could be improved

Same

Same

What is missing or could be improved
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Same
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What is missing or could be improved
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What is missing or could be improved



2024 Year End Summary 12/11/2024

12Copyright 2024 Santa Clara County ARES/RACES.  All Rights Reserved.

Copyright © 2024 Santa Clara County ARES®/RACES.  All rights reserved. 23

What is missing or could be improved

Continuation of the same form

No check-out of net or release from assignment
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What is missing or could be improved
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Credential Updates

Tim Howard, KE6TIM
Revised 11-Dec-2024
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Earned Credentials/Endorsements 2024
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Total Credentials and Endorsements
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Credentialing
• Credentialing in technical fields (usually called 

certification) has been used for 25+ years to verify an 
individual’s ability.

• Credentialing is becoming more prevalent in Emergency 
Management, especially where mutual aid may be 
utilized.

• The State of California has a credentialing program for 
EOC positions and many cities are having their staff earn 
credentials.

• Served agencies are increasingly aware of credentialing 
and are expecting team members to be credentialed.
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Credentialing

• Credibility: Credentials demonstrate your training, 
knowledge, skills, and experience; and enhances 
your credibility with peers and served agency 
personel.

• Commitment: Earning credentials demonstrates 
your commitment to the EmComm role, validates 
your acquired skills as a volunteer, and can open 
doors to leadership and training roles within the 
organization.  

• Assignments: Credentials can assure those that 
assign you to a task know that you are capable of 
handling whatever challenges the assignment 
presents. 
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Credentialing Program Handbook

https://www.scc-ares-races.org/credentials/index.shtml#overview
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Database Update

If you have a County DSW, the sticker on 
your DSW Card Expires at the end of 
December.

New stickers will be provided to your EC 
for distribution if you have updated your 
database contact information by 
December 31st.

Update/Verify Contact Info

Copyright © 2024 Santa Clara County ARES®/RACES.  All rights reserved. 32



2024 Year End Summary 12/11/2024

17Copyright 2024 Santa Clara County ARES/RACES.  All Rights Reserved.

Packet Network Update
2024 Year End Review

Jim Oberhofer, KN6PE
Revised 30 November 2024
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Highlights -- Outpost and PackItForms
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What’s in the box?

• SCCo Integrated Packet Installer 163C
*** PRERELEASE ***

• Outpost Packet Message Manager
– GUI-based interface for managing packet communications
– Makes using packet as simple as using e-mail

• PackItForms
– Next generation HTML-based forms for use with Outpost
– Manual operation without Outpost
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SCCo Installer v163C
September 2024

• Resolves 3 reported defects; adds 6 requested changes, including…
• Signature update on the ICS‐309 comm log
• Address book address expansion with sent messages

Outpost v3.8.6*

PackItForm 3.16*
• Various forms and .pdf updates
• Even better manual operation support

• Auto-logging of sent and received messages
• Updated ICS‐309 log maintenance
• Enhancements and bug fixes from user feedback

*See the release notes for details
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What’s new
(or 6 things to make your packet life easier)

1. Setting up Message ID prefix for Tac Calls
2. Packet Forms and Manual Packet
3. Message search
4. Monitor RF Packet Traffic 
5. Fixing JNOS extra line feeds
6. Packet Field References
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1. Setting up Message ID prefix for Tac Calls
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You are deployed with a tactical call.  You get a call from the EOC that 
the tac call message ID is not set up correctly.

Situation:

Message IDs are both unique and help reference the sending station.Problem:

With Outpost

1. Select Settings > Station ID…

2. When you fill in your FCC Call 
sign, Outpost picks up the last 
3 characters of your call as the 
Message ID Prefix.  

3. When setting up the Tactical 
Call, you need to fill it in 
yourself. 

4. Ask your shift supervisor or 
exercise coordinator for what
this field value should be.

Solution:

Monthly Exercise: Tac Call=XND056 Msg ID Prefix = X56
City Deployment: Tac Call=CUPDZA Msg ID Prefix = DZA

Examples:
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1. Setting up Message ID prefix for Tac Calls
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You are deployed with a tactical call.  You get a call from the EOC that 
the tac call message ID is not set up correctly.

Situation:

Message IDs are both unique and help reference the sending station.Problem:

Manual Operations

1. Find and click on manual.cmd

2. PackItForms  picks up 
the last 3 characters of your
FCC call as the Msg ID Prefix.  

3. The Tactical Call Msg ID Prefix
does the same, but may not be
correct.  

4. Ask your shift supervisor or 
exercise coordinator for what
this field value should be AND
change this field if necessary.

Solution:

Monthly Exercise: Tac Call=XND056 Msg ID Prefix = X56
City Deployment: Tac Call=CUPDZA Msg ID Prefix = DZA

Examples:

2. PackItForms
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County Use of PackItForms
• Santa Clara County PackItForms contains these public forms

1. XSC Check-In/Out Message Form 
2. XSC ICS-213 Message Form adapted for Santa Clara County to 

transmit messages.  
3. XSC EOC-213RR Resource Request Form – Requests specific resources 

needed to support an emergency.  
4. XSC OA Jurisdiction Status Form – Reports jurisdiction emergency 

situation status to county OEM.  
5. XSC OA Shelter Status Form – Reports information and status on 

shelters opened in the cities to county OEM.  
6. XSC Allied Health Facility Status – Reports information & status of 

private Skilled Nursing facilities to SCC Public Health Department.
7. XSC RACES Mutual Aid Request Form – Used by a jurisdiction to 

request a RACES Mutual Aid.
• The SCC Installer program automatically installs these packet forms 

along with Outpost.
– Additional forms may be provided by your EC
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Updated PackItForm Defaults

• Aligns with the RACES Recommended Form Routing Cheat Sheet; updated March 2024
• Updates are in BOLD text
• Fields can be changed at message create time
• Always double-check the RACES Recommended Form Routing Cheat Sheet for your 

specific situation

To LocationTO ICS PositionHandling OrderPackItForms

------ICS 213 Message Form

County EOCPlanning Section--EOC Resource Request 213RR

County EOCSituation analysis UnitImmediateOA Jurisdiction Status 

--Mass Care and Shelter UnitPriorityOA Shelter Status 

PHDOCEMS UnitRoutineAllied Health Status 

County EOCRACES Chief Radio OfficerRoutineRACES Mutual Aid Request 

PHDOCEMS UnitImmediateHAvBed Report

PHDOCEMS UnitImmediateMedical Facility Status

Obsolete -- Replaced by EOC Resource Request 213RRResource Request Form #9A
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3. Message Search
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This assignment has been in place for several shifts with plenty of 
packet message traffic already passed.

Situation:

Now, someone askes for a copy of a message you received. Where is 
it?

Problem:

1. On Outpost, click on the Search menu.

2. Enter some text that you know is likely part of the message, which 
fields it is in (or 
check all fields), 
and whether you 
want to check this
or all folders.

3. Press Search

4. For  All Folders,
Type field shows 
the message 
location.

Solution:

4. Monitoring Packet traffic
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Some users like to watch what is going on with on a frequency in 
between Send/Receive Sessions to see if the frequency is clear.

Situation:

1. From Outpost, Tools > Interactive Packet > Serial / Com Port.

2. From Ipserial, Tools > Options. Check  "Turn on Packet Monitoring 
(MON ON)…". Press OK.

3. When you press Connect, Ipserial.exe sends the MON ON command 
to the TNC to start monitoring. 

4. When Outpost starts a
Send/Receive session, it
requires the serial port.

• it tells Ipserial.exe to 
disconnect.

• It opens the com port 
and sends the necessary
TNC & BBS commands.

• When done, it tells 
Ipserial to reconnect to 
the Com Port. 

Solution:
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5. Fixing JNOS Extra Line Feeds
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JNOS causes message text lines greater than 127 characters to have a 
CR/LF inserted regardless of where it is in a sentence or word.  
PackItForms handles this situation nicely.  But what happens if an 
Informal Message is sent?  This is what it could look like…

Situation:

Copyright © 2024 Santa Clara County ARES®/RACES.  All rights reserved.

5. Fixing JNOS Extra Line Feeds

46

If you come across this situation, try this:
1. In the message form, press View > JNOS Line Fix (BETA)
2. This change is not permanent and cannot be saved.
3. Pressing the forms’ Print button will print the original message.

Solution:
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5. Fixing JNOS Extra Line Feeds

47

4. But, pressing File > Print will print the corrected version.Solution:

What is it
• an Unofficial SCCo RACES reference. 
• Provides a reminder (job aid) for 

how to perform tasks that need to 
occur during a packet field 
deployment.

• Helps ensure task consistency, 
completeness, and operational 
alignment with SCCo RACES policies 
and procedures.

What it is not
• the only source of information on 

which you should rely.
• an official SCCo RACES deliverable.

6. Amateur Packet Radio
Field Reference, Type III
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6. Amateur Packet Radio
Field Reference, Type III

https://bit.ly/PacketT3
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6. Amateur Packet Radio
Field Reference, Type II

https://bit.ly/PacketT2
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mpmp, P1 and HF 
Credentials & SHARES

Mark Laubach, K6FJC
14-Dec-2024
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Monthly Packet Messaging Passing Practice
January to November stats
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Not HeldNot Held

TotalsNovOctSepAugJulJunMayAprMarFebJan

169152716111620192124Participants

Messages by participant by Type

337424039332840572929ICS213

112212719111420EOC213RR

59281120Shelter Status

2222Allied Health Status

371126RACES Mutual Aid

401426CSV

150820831121638?205249281Op-to-Op & Other

5684602913617330387577674768816Total Messages

You can review all past practices on the MPMP Training Page:
https://www.scc-ares-races.org/training/practice/monthly-packet-message-practice/monthly_packet-message-practice.html
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Packet Credential Changes
• Packet Operator Type I (P1)

• Removing: out of county assignments
• Moving out of P1 to a new area of focus:

• Set up, manage, and troubleshoot a JNOS-based packet BBS 
system, running on Ubuntu, etc.

• Changing focus to W5XSC BBS to set up and operate for a training or 
exercise event, with instructions from net team

• Refining knowledge items, digipeaters and nodes, and other problems
• Etc. 

• Motivations
• P1 should be on parallel with other Type 1 credentials, e.g., specialist 

and plan, design, deploy, train, …
• It’s a lot of work to complete existing requirements
• P1 credential != county BBS sysop

• Doesn’t need to incorporate SCCo BBS sysop/network

• When: next Credential Program Handbook update
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Member of County Networking Staff 
• The network team is looking for a few “good people”

• In discussion likely in the form of a member of 
network staff position posting (likely)

• Discussed new endorsement not the way to go
• Recommendation from CRO and Pkt Manager
• Prerequisites: P2+, demonstrated team player
• Not for everyone, interview will be required with credential evaluator 

and network team member – think of a position posting
• Successful interview,, candidate will be assigned mentor
• County BBS knowledge and demonstration (for all candidates)

• Building Ubuntu-based JNOS system to county configuration
• BBS JNOS sysop privileges demonstration, message and notice 

management, log maintenance, Ubuntu tcp/ip networking, etc.
• Knowing what and what not to touch

• Additional skillsets desired among one or more of the following
• Network management, Network security, firewalls, monitoring, Network 

routing, email (configuration, spam), devops, analysis, logging, 
maintenance and upgrades, SCCo BBS operational knowledge, etc.

This is all under consideration and development
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Changes in County EOC Radio Room
HF Radio Remove / New State-funded HF Technology

• New radio technology has reduced the need for HF radio users to 
deal with the complexities of HF propagation (solar conditions, time 
of day, antenna orientation, etc.)
• State has called this SHARES for SHAred RESsources
• SCCo OEM has two rigs: EOC radio room fixed and mobile unit

• The use of new technologies all but eliminates the need to be 
concerned about HF propagation for state-wide EmComm purposes.

• The need for a three level HF Credential is being removed from the 
Credentialing Program and a “SHARES Radio Operator 
Endorsement” is being added to the next version of the Credentialing 
Program Handbook.
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• The “SHARES Radio Operator Endorsement” will be available to anyone 
holding the EOC Radio Operator Endorsement.

• Early next year we will offer a SHARES HF Radio Orientation class for 
those interested.

Quick Overview
• Based on Codan Communications equipment (Australia)
• Limited to state civil defense and emergency management agencies and some 

select agencies within the state of California.
• Shared channels in the 2 to 8 MHz range.  Access to 10 channels providing point-

to-point emergency radio coverage across the state.  24x7 Link Quality Analysis 
and Automatic Link Establishment to eliminate ToD propagation concerns

• Operates in accordance with FCC Rules Part 90 – Private Land Mobile Radio 
Services (primary) and Part 97 Amateur

• All ”push button”

Changes in County EOC Radio Room
HF Radio Remove / New State-funded HF Technology
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Pactor Modem

Desk 
Console 

Codan 
Envoy
Transceiver

Power 
Supply

SHARES Base Station HF Equipment
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SEMS - Reminder
Standardized Emergency Management System
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SEMS General Flow of Requests and Resources
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NOTES
• Local governments may request 

mutual aid directly from other 
local governments where local 
agreements exist.

• Discipline-specific mutual aid 
systems may have procedures 
that provide additional methods 
of obtaining state resources.

• Volunteer and private agencies 
may be involved at each level.

• OA encompasses a county
• 58 counties

• Six mutual aid regions

Weekly Packet Practice

Steve Roth, KC6RSC
Revised 11-Dec-2024

Copyright © 2024 Santa Clara County ARES®/RACES.  All rights reserved. 60
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32.034.327.430312925.5Unique Calls
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Mailbox Full — Now What?

You are assigned to a rarely used station.
You connect to the BBS, and it has 142 
messages waiting.  That will take forever!
1. Abort the connection
2. Switch to alternate BBS
3. Connect manually, list with LL.  If the 

backed-up messages are obsolete or 
unimportant, kill them with K.
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Can’t Wait for Bulletins to Download?

You’re waiting for a critical message but 
Outpost wants to download the XSCPERM 
bulletins.  That will take too long!
1. Abort the connection
2. Outpost: Setup → BBS → Receiving
3. Turn off “Retrieve Bulletins” checkbox.

(Don’t forget to turn it back on later!)

Copyright © 2024 Santa Clara County ARES®/RACES.  All rights reserved. 66



2024 Year End Summary 12/11/2024

34Copyright 2024 Santa Clara County ARES/RACES.  All Rights Reserved.

Switching between RF and 
TCP/IP network access

in Outpost
Using Profiles extensively

Andreas Ott, K6OTT
Revised 11-Dec-2024
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● you are in an EOC or tactical location
● you know your primary and secondary
BBS, your tactical call, your FCC call –
and know how to configure all this in
Outpost
● your main access to the BBSen has
been over RF
● you recently got connected to the 
SCCo Systems TCP/IP Subscriber 
Network (or your EOC location has 
a wired Ethernet connection to our
network)

BBS settings and access paths
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● No Issues: you are using your primary BBS over RF
● primary BBS “unreachable”: you manually switch to the 

secondary BBS, and announce this fact on a net to the 
County EOC (and other stations) so that they can adjust 
sending you messages to your secondary BBS address

● primary BBS “reachable”: you have the choice of 
continuing on the secondary BBS or switching back to 
the primary BBS (same…, announce it, so others know 
where to find you)

→ your easiest way of “switching around” is by using 
Outpost Profiles

Workflows on RF
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● the default Outpost profile after new install is “Outpost”

● create new profile (naming convention below)
● for your primary BBS, device and StationID
● test it!
● repeat for your secondary BBS, then test some more!
● practice switching between profiles, do not forget to 

“switch” and verify the radio frequency at the same time
● switching between RF bands on the same BBS without 

changing the profile

Create RF Profiles
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● BBS name
● device/connection
● Interface name
● StationID 

(your callsign, tactical or FCC)

● Create, save as (use ~ in profile name as separator)

Examples: 
● W1XSC~KPC3~COM5FTDI~K6OTT
● W1XSC~TELNET-W1XSC~K6OTT

Profile Parameters
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< Station ID             

TNC/ComPort > 

finally: Save it

Parameter details
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● for your primary BBS, telnet connection and StationID
● add username and password, remove colon “:” from 

password prompt field
● test it!
● repeat for your secondary BBS
● test some more!

● when switching back to any RF profile, do not forget to 
“switch” and verify the radio frequency to match the 
BBS frequency on that band at the same time

Create Telnet Profile
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< new
IP, port >

prompt >

BBS username
and password >

Telnet details
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● No Issues: you are using your primary BBS over telnet
● primary BBS “unreachable”: you manually switch to the 

secondary BBS, and announce this fact on a net to the 
County EOC (and other stations) so that they can adjust 
sending you messages to your secondary BBS address

● primary BBS “reachable”: you have the choice of 
continuing on the secondary BBS or switching back to 
the primary BBS (same…, announce it, so others know 
where to find you)

→ your easiest way of “switching around” is by using 
Outpost Profiles

Workflows on Telnet
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Always verify Outpost status bar on the bottom

Switching around
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For Outpost, see training slide decks from SCCo 
ARES/RACES Packet Operations classes

Packet Operations - Type III, Part A
Packet Operations - Type III, Part B
Packet Operations - Type II

and of course the Outpost Documentation

References

Copyright © 2024 Santa Clara County ARES®/RACES.  All rights reserved. 77

Safety issue observed:
no fuses in power cables

Batteries are no fun

Andreas Ott, K6OTT
Revised 11-Dec-2024
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● Energy content in a (SLA) battery:
3.6 * voltage * mAh = Energy [Joule]
Example: SLA 12V@18Ah
3.6 * 12 * 18,000 ≈ 777 kJ
(approximate energy needed to boil 1/2 gal of water 
from room temp)

● Energy density in LiFePO4 battery:
> 3x of SLA battery by weight, also 
higher load current possible

Energy content in a battery
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Now picture this: if your battery shorts 
out, you will set free most of the energy 
in a fraction of one second (aka. boil 
the water in < 1 second). Until 
something fails, such as the wire 
melting, or the battery liquids heat past 
their boiling point, with “steam” quickly 
escaping.

The Big Short
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Escaping electrolyte steam usually leads 
to the entire battery exploding. [*]

Good engineering practice is to insert 
something into the circuit that will fail 
before it turns into an incident, 
preferably a protective device such as a 
fuse. “All circuits shall have fuses”.

* “Don’t try this at home - go to a friend’s house.”

Rapid Unscheduled Disassembly
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image credit: K0BG/Yaesu

Protecting battery and load (equipment)

Fuses to the rescue
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Check the manual: They will recommend 
minimum wire sizes and fuses, at least 
at the battery and the power source!

image credit: Renogy

DC Load:
20 amps
cutoff

Charge controllers with 
electronic load limiters

Working with a Served Agency
Golden Eagle 2024

Jeff Grafton, AJ6XZ
Revised 10-Dec-2024
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• Simulated M7.5 earthquake
• County OEM established Type III C-POD 

in Hellyer Park
• Simulated cell phone outage at site

• RACES mobilized to provide comms 
between C-POD site and EOC

Golden Eagle 2024: Hellyer Park C-POD
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Golden Eagle 2024: Hellyer Park C-POD
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• RACES wasn’t in the org chart…

Golden Eagle 2024: A few surprises
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… or the 
site map

Golden Eagle 2024: A few surprises
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Golden Eagle 2024: Field Setup
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• FRS radios were used for 
on-site comms

• The IC expected RACES 
would handle all comms, 
including FRS

• RACES staff had not been 
briefed on use of FRS

Golden Eagle 2024: More surprises
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• Many incident staff (including IC) were 
unfamiliar with forms and message flow to 
EOC

Golden Eagle 2024: Message flow

• RACES provided 
blank forms and 
coaching

• Handing off the 
Recommended 
Form Routing 
Cheat Sheet 
worked wonders 
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• RACES sent and received multiple 3rd-
party messages over packet and voice
• ICS-213
• 213RR with routing slip
• Informal

• Cross-trained operators
• Able to fill in while others were coaching 

incident staff or taking breaks

Golden Eagle 2024: Operations
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• Exercising with served agencies is 
invaluable

• Keep current on training and practice so 
you know how message flow works

• Semper Gumby!

Golden Eagle 2024: Takeaways

W2XSC BBS Failure
June 8th – 16th

Tim Howard, KE6TIM
Revised 16-Nov-2024
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Initial Evaluation
• Problems with W2XSC were reported

• A number of remote troubleshooting steps were taken.
o The network connection between the BBS PC and 

the other network infrastructure at the site had failed.
o The JNOS BBS, the TNCs, and the Radios were 

fully functional.
o The BBS was usable as a standalone BBS without 

external connectivity to the rest of the network.

• It was determined that a spare computer, data switch, 
and data cable should be taken to the site.

• Because of the remote location of the site, other parts, 
tools, and equipment were collected for the trip.
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Plan for Trip to Site
• Over a one hour drive one-way

• Take anything you might need.  Spare parts for repair 
and also backup monitor, keyboard, mouse, tools, etc.

• Need a high clearance vehicle in good weather, 4WD at 
other times.

• Because of the remote location we want to send at least 
two people.

• It took a couple of days to get the material together.

• The keys to access the site were not readily available.

• Once on site, it was quickly determined there was a 
cable issue.
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Initial Visit
• Cable was replaced

• TNC Firmware updated

• General cleaning and 
inspection of cabinet

• Remote testers 
checked all radio, BBS, 
and email connections 
to the site

• The site was up and 
back to normal 
operation 
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Less than 16 hours later
• The BBS failed with the exact same symptoms.  Remote 

diagnostics indicated a similar failure.

• A second visit the next day was scheduled with spare 
parts, a hardened data cable, and mouse deterent.
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Second Visit

• The same data cable was chewed breaking wires
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• The data cable was replaced with the shielded cable.
• No additional problems with mice eating cables
• Site owner has placed more traps and sealed any 

openings found.  Reminded tenants to keep door closed.

• Thanks to:
Thomas Leibold – spare parts and technical expertice
Bertrand Achard – extra tools and computer monitor
Tim Howard – driver and support
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Additional W2XSC Issues
• PG&E PSPS power shutdown

o Generator started but shutdown failed due to 
overheating

o Fan Blades were broken providing no cooling air
o Mice or larger rodents had got inside the fan shroud 

and when engine started the fan blades broke off.
o Our batteries did not work due to several years of use 

with numerous PG&E and generator issues

• Site owner has enclosed all openings to the generator 
with wire mesh to allow air flow but block mice and other 
rodents from access

• New batteries are on order and when they arrive a site 
visit will be scheduled

Q&A
All Training Staff
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Thank You!
Please check your email and follow the instructions to 

complete and return the Course Evaluation. 

To get course credit the Course Evaluation is due by next 
Saturday.

If you have questions or feedback about this or other training activities, 
you can join our Training discussion group.
https://scc-ares-races.groups.io/g/training

This is a moderated group.

See you at a training class or exercise next year!
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